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ABSTRACT
This set of instructions for producing a proceedings paper for The Society for Modeling & Simulation International (SCS) with Microsoft Word also serves as a sample file that you can edit to produce your submission, and a checklist to ensure that your submission meets the SCS requirements. Please follow the guidelines herein when preparing your paper. Failure to do so may result in a paper being rejected, returned for appropriate revision, or edited without your knowledge. Note that initial submissions are double blind, so authors must not be included when submitting your manuscript.
Keywords: instructions, author’s kit, conference publication. (3-5 keywords separated by a comma.)
INTRODUCTION
This paper provides instructions for the preparation of papers for the Society for Modeling & Simulation International (SCS) with Microsoft Word. There is a companion paper that provides instructions for the preparation of papers using LaTeX. The preferred format for the conference is LaTeX and we encourage authors to use our Overleaf template. We also allow for submissions prepared via Microsoft Word. The easiest way to write a paper using Microsoft Word that complies with the requirements is to use the template file. Please do not use an older version, as some specification may have changed. An author kit is available via conference website. The author kit includes this Microsoft Word document, its LaTeX companion and an Overleaf template. When preparing your paper in Word, you are required to this Word. 
A set of styles are defined in the template so that authors can easily achieve the required format. You should look carefully at how the styles are applied in this document. One simple way to get started with styles is to start with the present sample paper and simply replace the existing text. Do not try not to make “manual” formatting changes to the text, simply apply the corresponding predefined style from Table 1 and let styles do the work. The Styles panel also shows the style currently applied to the text at the current cursor position as the boxed style in the list. To apply different formatting, choose the appropriate style from the list. The specific formatting instructions for a style may be viewed by placing the cursor over the style of interest. Avoid updating the styles that are provided.
Table 1: Defined Word styles.
	Style Name
	Description

	Abstract Heading
	Heading style for Abstract

	Appendices
	Appendix heading

	Biography
	Author Biographies

	Equation
	Equations

	Figure Label
	Single-line figure caption

	Figure Label Multiline
	Multi-line figure caption

	Heading
	Unnumbered headings – e.g. References, Acknowledgments, Author Biographies, etc.

	Heading i
	Numbered headings for level i headings

	Hyperlink
	Hyperlinks

	List Bulleted
	Bulleted lists

	List enum
	Numbered lists

	Normal
	Normal text – no indent

	Program
	“in-between” lines in a program listing

	ProgramBoth
	Single-line program statements

	ProgramEnd
	Last line in a program listing

	ProgramStart
	First line in a program listing

	Table Label
	Single-line table caption

	Table Label Multiline
	Multi-line table captions

	Title
	Paper Title



Note that some styles appearing in this paper’s styles set are not found in earlier templates. The safest way to ensure conformance to formatting requirements is to apply only styles that are listed in Table 1.
GENERAL GUIDELINES
Language
The paper should be prepared using U.S. English in the interest of consistency across the proceedings. The language can be set in MS Word 2010 via File > Options > Language settings, and selecting “English (United States)” from the drop down menu.
Objectivity
The content of the paper should be objective and without any appearance of commercialism. In general, comparisons of commercial software should be avoided unless they are central to the topic. If a comparison of commercial software is included, it should be based on objective analysis that includes criteria, description of ranking methodology on each criteria, and the rankings themselves to arrive at the conclusion. If an approach other than a detailed objective analysis is used to select the simulation software used for the study being reported, such as, availability of the software, or the familiarity of the analyst with the software, it should be clearly identified. To ensure suitability for an international audience, please pay attention to the following:
· Write in a straightforward style.
· Try to avoid long or complex sentence structures.
· Briefly define or explain all technical terms that may be unfamiliar to readers.
· Explain all acronyms the first time they are used in your text – e.g., “Digital Signal Processing (DSP)”.
· Explain local references (e.g., not everyone knows all city names in a particular country).
· Explain “insider” comments. Ensure that your whole audience understands any reference whose meaning you do not describe (e.g., do not assume that everyone has used a Macintosh or a particular application).
· Explain colloquial language and puns. Understanding phrases like “red herring” may require a local knowledge of English. Humor and irony are difficult to translate.
· Use unambiguous forms for culturally localized concepts, such as times, dates, currencies and numbers (e.g., “1-5- 97” or “5/1/97” may mean 5 January or 1 May and “12/10/11” can be even more confusing, and “seven o’clock” may mean 7:00 am or 7:00 pm).  For currencies, indicate English equivalences – e.g., “Participants were paid 10,000 lire, or roughly $5.”
· Be careful with the use of gender-specific pronouns (he, she) and other gendered words (chairman, manpower, man-months). Use inclusive language that is gender-neutral (e.g., she or he, they, s/he, chair, staff, staff-hours, person-years).
· If possible, use the full (extended) alphabetic character set for names of persons, institutions, and places (e.g., Grønbæk, Lafreniére, Sánchez, Universität, Weißenbach, Züllighoven, Århus, etc.).
Paper Submission
Please, refer to the author’s guidelines document in the author’s kit.
Length Constraints
The Abstract and Keywords
The abstract should be at most 150 words. Since abstracts of all papers accepted for publication in the proceedings will also appear in the final program, the length limit of 150 words will be strictly enforced for each abstract. The abstract should consist of a single paragraph, and it should not contain references or mathematical symbols. 
The list of keywords should have no more than five keywords that will identify your paper in indices and databases (required). Do not use the words “computer”, “simulation”, “model”, or “modeling”, since these are all assumed.
Length of the Paper
The page size in the proceedings must be 8.5 inches by 11 inches (21.6 cm by 27.9 cm). The overall length of the paper should be at least 5 proceedings pages. Papers should be at most 12 pages.
Font Specification and Spacing
The paper should be set in the Times New Roman font using a 11-point font size and it should be single spaced. Do not use other fonts; the use of other fonts means the proceedings editors will need to send the paper back to you to change the font.
Margins
The width of the text area is 6.5 inches (16.0 cm). The left and right margins should be 1 inch (2.54 cm) on each page. The top margin shall be 0.89 inches (2,24 cm) including the header, the bottom of the pages shall be 0.67 inches (1.7 cm). Please do not change the margins and use the template.
Justification
Headings of sections, subsections, and subsubsections should be left-justified. One-line captions for figures or tables should be centered. A multiline caption for a figure or table should be fully justified. All other text should be fully justified across the page (that is, the text should line up on the right-hand and left-hand sides of the page).
Headings of Sections, Subsections, and Subsubsections
Section, subsection, and subsubsection headings should appear flush left, set in the bold font style, and numbered as shown in this document. The headings for the Abstract, Acknowledgments, References and Author Biographies sections are not numbered. Section headings should be set in FULL CAPITALS LIKE THIS PHRASE, while subsection and subsubsection headings should be Capitalized in Headline Style like This Phrase. Lengthy headings should be broken across two or more lines. Again, these formats should be accomplished using the styles Heading 1, Heading 2, Heading 3, etc.
Paragraphs
The paragraphs should not be indented. Normal style will add a space between paragraphs, do not insert additional space between paragraphs.
Footnotes
Do not use footnotes; instead incorporate such material into the text directly or parenthetically.
Page Numbers
Do not include page numbers. Page numbers are generated by the proceedings editors once all accepted papers are ordered for the final proceedings.
FORMATTING THE FIRST PAGE
Running Heads
The running head (provided in the template) in the lower left-hand corner of the first page is left-justified and set in the 9-point italic font style. 

Running heads on the second and subsequent pages should contain the last names of the authors, centered and set in the 10-point italic font style. For example, running heads for papers with varying numbers of authors would appear like Yilmaz (single author), or Yilmaz and Chan (two authors), or Yilmaz, Chan, and Moon (three authors), or Yilmaz, Chan, Moon, and Roeder (four authors).
List all authors; do not use et al. The author names are listed in the same order as they appear on the title page. This will be the same order when providing the author biographies at the end of the paper. On the second page of your document, view the Header and make the appropriate changes.
Title and Authors
Center the title of the paper on the page and set it in bold 12pt FULL CAPITALS. There should be 2 blank lines before the title so that the top edge of the title begins at least 1.25 inches from the top of the page. Multiline titles should have about the same amount of text on each line. There should be 1 blank line between the title and the authors’ names. 
Each author’s name should be centered on a new line, with the author’s first name first and no job title or honorific. Insert 1 blank line between the author’s name and address. The organization or institution that the author is affiliated to should be typed first. Next type the complete street address, without abbreviations, followed by the city, standard two-letter state or province abbreviation, and country. The address should be centered. For papers with multiple authors, the authors should be listed in order of decreasing contribution, with authors from the same institution listed jointly. Different formats for multiple authors are shown as examples in Figures 3-7 at the end of this document. There should be 1 blank line between the author names and the text of the paper. The authors are provided in a table so adding and deleting columns is done via the table commands. Authors with multiple affiliations shall pick the main affiliation for the title page and mention other affiliations in their biography.
FORMATTING SUBSEQUENT PAGES
Please refer to Section 2.4.4 for the correct margins.
Mathematical Expressions in Text and in Displays

Display only the most important equations, and number only the displayed equations that are explicitly referenced in the text. To conserve space, simple mathematical expressions such as  may be incorporated into the text. Mathematical expressions that are more complicated or that must be referenced later should be displayed, as in


If a display is referenced in the text, then enclose the equation number in parentheses and place it flush with the right-hand margin of the column. For example, the quadratic equation has the general form

									(1)
In the text, each reference to an equation number should also be enclosed in parentheses. For example, the solution to (1) is given in (2) in Appendix A. Note that equation numbers are not automatically generated or referenced.
If the equation is at the end of a sentence, then you should end the equation with a period. If the sentence in question continues beyond the equation, then you should end the equation with the appropriate punctuation - that is, a comma, semicolon, or no punctuation mark.
The equations can be entered using the Equation option available in the Symbols group on the Insert tab in Microsoft Word 2007 or 2010, or using Microsoft Equation Editor in older versions of Microsoft Word. For Microsoft Word 2007 or 2010, the equation capability makes entering equations quite convenient but numbering them requires using tables.
If you are using Microsoft Equation Editor 3.0, then select the “Equation” style on the line where the equation will appear. Then press the TAB key to move the cursor to the center of the column. From Word’s Insert ribbon, select Object in the Text group. In the pull down menu that appears, select Object, and in the Object panel, select type Microsoft Equation 3.0, and type the equation. While in the Equation Editor, you should verify that the font size is at most 11 points. On the Equation Editor’s menu bar, select Size > Define, and set the “Full” font size to 11. Close the Equation Editor. If you want to include the equation number, press the TAB key. This will move the cursor to the right-hand margin; then type the equation number enclosed in parentheses. Insert a blank line after the equation and then return to the “Normal” style to continue a paragraph or to start a new paragraph.
If you are using MathType, insert a blank line before the line for the equation. Click the “Insert Display Equation” button on MathType’s Equation Editor menu bar. Before you type the equation, verify that the font size is at most 11 points by choosing Size > Define. After typing the equation, close the MathType Equation Editor, press the TAB key to move the cursor to the right margin, and type the equation number, if any, enclosed in parentheses.
Displayed Lists
A displayed list is a list that is set off from the text, as opposed to a run-in list that is incorporated into the text. The bulleted list given below provides more information about the format of a displayed list. 
Use standard bullets instead of checks, arrows, etc. for bulleted lists.
For numbered lists, the labels should not be Arabic numerals enclosed in parentheses because such labels cannot be distinguished from equation numbers.
Do not indent the paragraph after the list. It is not necessary to include an empty line before and after the list.
Use standard numbering instead of special characters for numbered lists.
For numbered lists, the labels should not be Arabic numbers enclosed in parentheses because such labels cannot be distinguished from equation numbers.
You may need to restart the numbering on numbered lists. To do so, right click on the first entry in the list.
Definitions and Theorems
Definitions, theorems, propositions, etc. should be formatted like a normal paragraph with a boldface heading as shown in the examples below. Number these items separately and sequentially. You may choose to separately number theorems, propositions, corollaries, etc., as opposed to the example below where corollaries and theorems are numbered together.
Use a period after the definition, theorem, corollary or proposition number.
Definition 1. In colloquial New Zealand English, the term dopey mongrel is used to refer to someone who has exhibited less than stellar intelligence.
Theorem 1. If a proceedings editor from New Zealand accidentally deletes his draft of the author kit shortly after completing it, he would be considered to be a dopey mongrel.
Corollary 2. One of the proceedings editors is a dopey mongrel.
The paragraph after the list is not indented.
Figures and Tables
Figures and tables should be centered within the text and should not extend beyond the right and left margins of the paper. Figures and tables can make use of color since the SCS produces electronic proceedings. However, try to select colors that can be differentiated when printing in black and white in consideration of vast majority of people using such printers. Figures and tables are numbered sequentially, but separately, using Arabic numerals. All tables and figures should be explicitly referenced in the text and they should not be placed before they are referenced.
To insert a table, use the usual Table option on the Insert ribbon. To center the table, first select the table, then right click and select Table Properties, followed by the Table tab and click the Center button for Alignment and the None button for Text wrapping. For figures which can fit next to each other, the author can choose to align them next to each other with the figure text centered below each figure and on the same line for both figures. For tables which can fit next to each other, the author can choose to align them next to each other with the table text centered above each table and on the same line for both tables.
Each table should appear in the document after the paragraph in which the table is first referenced. However, if the table is getting split across pages, it is okay to include it after a few paragraphs from its first reference. One-line table captions are centered, while multiline captions are left justified. This template does not use the Word capabilities to insert table captions and thus does not use the automatic referencing capabilities of Word. Instead add the appropriate caption above the table and use the “Table Label” style for tables with a single-line caption.
Use the “Table Label Multiline” style for multiline table captions. The styles include inserting a 12 pt. space above and a 6 pt. space after the caption. The caption should begin with the word Table, followed by the table number and a colon. Captions can be written using normal sentences with full punctuation. All captions should end with a period. It is fine to have multiple-sentence captions that help to explain the table. Include one line space below the table. See Tables 2 and 3 for examples.
Table 2: Table captions appear above the table, and if they are longer than one line they are left justified. Captions are written using normal sentences with full punctuation. It is fine to have multiple-sentence captions that help to explain the table.
	Creature
	IQ
	Diet

	dog
	70
	anything

	cat
	75
	almost nothing

	human
	60
	ice cream

	dolphin
	120
	fish fillet




Table 3: Counting in Maori.
	English
	Maori

	one
	Tahi

	two
	Rua

	three
	Toru



Each figure should appear in the document after the paragraph in which the figure is first referenced. However, if the figure is getting split across pages, it is okay to include it after a few paragraphs from its first reference. Figure captions appear below the figure. Single-line captions are centered, while multiline captions are left justified. This template does not use the Word capabilities to insert figure captions and thus does not use the automatic referencing capabilities of Word. Instead add the appropriate caption below the figure and use the “Figure Label” style to label the figure for a single-line caption.
Use the “Figure Label Multiline” style for multiline captions. The styles include inserting a 6 pt. space above and a 12 pt. space after the caption. Include one line space above the figure. The caption should begin with the word Figure, followed by the figure number and a colon. Captions end with a period. See Figures 1 and 2 for examples. Paste figures as pictures into the document. With the picture selected, apply the “Centered” style.

[image: ]
Figure 1: An unusual answer to a question.

[image: ]
Figure 2: The area of the square is 64 squares, while that of the rectangle is 65 squares, yet they are made of the same pieces! How is this possible?
References to tables and figures are given as Figure 1 or Table 2. For example, “We see in Table 5 that…” and “We see in Figure 4 …” are both correct.
Please ensure that your graphics files use standard fonts (Times New Roman, Symbol, etc.) or that those are embedded in the final figure files. If they are not embedded, and if the font is not available on the editor's computer, then the font will not be included in the final PDF. This may lead to a problem with displaying the final PDF file on computers without an appropriate font. At best you select a format which allows to embed the fonts in all non bitmap figure files.
Hyperlinks
A hyperlink specifies a Web address (URL) or an e-mail address. The use of hyperlinks allows authors to give readers access to external electronic information, such as a dynamic simulation or animation. But please note: hyperlinks (to web pages) might not work forever (web pages might be removed), and thus using hyperlinks intensively may make a paper (or parts thereof) less useful in future. If enough information is provided in the main body of the paper to enable searching for the cited content in any case and if the inclusion of the web address does not hurt the appearance of the paper, then the web address can be included in the main body of the paper itself. 
While the use of hyperlinked text is encouraged in the main body of the paper, it is recommended that corresponding web addresses and other identifying information should be provided in list of references. For example, instead of spelling out the web address of the conference website, one would refer to conference website and the corresponding entry in the reference section will spell out the associated web address and other relevant information such as author(s) and/or organization that published the content. This would allow readers to search for the content using the author(s), organization, etc. in case the actual web-address is changed. This also allows for a cleaner appearance of the main body of the paper. 
Each hyperlink should be set in the same font as the text. Hyperlinks are not underlined. A live hyperlink (or hot link) - that is, a hyperlink that will activate your Web browser and take it to an external Web site or that will activate your e-mail software for sending a message to a specific e-mail address - should be colored blue. You can see examples of such hyperlinks in this paper. The use of live hyperlinks is at the discretion of the author(s).
Non-live hyperlinks that is, the hyperlinks that are included for the reader’s information but do not actually invoke the reader’s Web browser or e-mail software should be colored black
Using live hyperlinks requires the format defined in the “Hyperlink” style. To insert a live hyperlink into a SCS paper, please follow the following steps:
1. In the current paragraph style, enter the text where the live hyperlink is to appear.
1. Select the displayed text of the live hyperlink and apply the “Hyperlink” style.
1. With the displayed text selected, choose Insert > Hyperlink from the ribbon or right-click and select “Hyperlink.”
1. In the dialog box that appears, select the button labeled “Existing File or Web Page” or “E-mail address.” 
1. In the second box labeled “Address” type only the correct e-mail or Web address, with the prefix http:// for a Web address.
1. For hyperlinks with web addresses, enter an appropriate citation following the text and provide the web address and other relevant information in the corresponding entry in the list of references.
If it is necessary to break the displayed text of the e-mail or Web address across two or more lines, then a soft return (SHIFT+ENTER) may be used to insert line breaks in the displayed text of the live hyperlink (as opposed to being inserted in the “Address” box referred to above). These soft returns should be added to the displayed text prior to step 3. If any editing is made to the displayed text of a live hyperlink, then the “Address” box referred to above should be rechecked to ensure no extraneous characters have been introduced into that box.
If the authors use hyperlinked text in the main body of the paper, they must ensure that each hyperlink includes a citation following the hyperlinked text, a corresponding entry is provided in the list of references, and the associated web address displayed for the hyperlink is complete and correct so that a reader who has only a hard copy of the paper can still access the cited material by typing the relevant part of the displayed text of the hyperlink into the address bar of a Web browser. If the authors opt for including the web address in the main body of the text itself, they must ensure that the hyperlink is complete and correct for the same reason. Again, it is recommended that corresponding web addresses and email addresses should be provided in the references.
Using the Bibliography
Citing a Reference
References are numbered. For example, you would use [1] to cite your first reference. When citing multiple references, you can use [1, 5, 7] or [1–4] if they span a range. Do not use the author-date method with (Author-name, Year) as it is no longer accepted in the template. We use the same reference format as IEEE.

List of References
Place the list of references after the appendices. The section heading is REFERENCES. The heading is not numbered. List only references that are cited in the text. Arrange the references in the order in which you used them, and number references accordingly.
Give complete references without abbreviations. 
Use hanging indentation to distinguish individual entries. Do not insert additional space between references. 
Please see the REFERENCES section on page 12 for examples.
Be sure that references include all of the necessary information such as full name of the publication, year, name of the proceedings, journal or book title, page numbers, etc.
AUTHOR CHECKLIST
We strive for a consistent appearance in all papers published in the proceedings. If you used the template and styles within this author’s kit, then almost all of the requirements in this checklist will be automatically satisfied, and there is very little to check.
Please print a hardcopy of your paper, and go over your printed paper to make sure it adheres to the following requirements. Thank you!
1. Abstract
6. 150 or fewer words.
6. Provide 3-5 keywords (mandatory). This set of keywords will identify your paper in indices and databases. 
1. Paper Length
7. At least 5, but no more than 12 pages.
7. Page size is letter size (8.5’’ x 11’’, or 216 mm x 279 mm).
1. All text is in 11-Point Times New Roman except title, header and footer.
1. Paper title is in 12-Point Times New Roman BOLDFACE ALL CAPS.
1. The paper has been spellchecked using U.S. English. 
1. Spacing and Margins
11. Single spaced.
11. Left and right margins are each 1 inch.
11. Top and bottom margins are according to the template.
11. Title starts 1.25 inches from the top of the page.
1. Section Headings
12. Left justified and set in BOLDFACE ALL CAPS.
12. Numbered, except for the abstract, acknowledgments, references and author biographies.
12. Subsection headings are set in Headline Style.
1. No footnotes or page numbers.
1. Multiple authors are formatted correctly.
1. Equations are centered and any equation numbers are in parentheses and right-justified.
1. Figures and Tables
16. All text in figures and tables is readable.
16. Table captions appear above the table.
16. Figure captions appear below the figure.
1. Citations and References
17. Citations are by numbers between brackets. 
17. References are in the hangref style, and are listed in the order they are cited in the text. 
1. Author biographies are one paragraph per author.
1. Hyperlinks
19. Be sure that hyperlinks will probably work in the future as well.
19. Live hyperlinks are blue. Nonlive hyperlinks are black.

After verifying that your paper meets these requirements, please go to the final submission page at conference website and submit your paper. Be sure to complete the transfer of copyright form and upload the .pdf receipt. Thank you for contributing to the SCS conferences!
ACKNOWLEDGMENTS
Place the acknowledgments section, if needed, after the main text, but before any appendices and references. The section heading is not numbered. These instructions are adapted from the version by Roeder, T. M. K., Frazier, P. I., Wotton, H., Szechtman, R., Yooh, H. L., Harker, J., and Zhou, E. Those instructions were adapted from WSC instructions with permission from WSC BoD [7] that have been iteratively updated and improved by proceedings editors and several other individuals, who are too numerous to name separately since the first set of instructions were written by Barry Nelson for the 1991 WSC.
APPENDICES
Place any appendices after the acknowledgments and label them A, B, C, and so forth. 
The solution to (1) has the form

											(2)
GETTING HELP
If you need help in preparing your paper, contact the proceedings editors. You can reach the entire team by writing to our unified point of contact at scs@scs.org. 
MOST OBSERVED MISTAKES
The following list comprises the most common sources of error that had to be corrected by previous editors. Please make sure to go through the following list and check that your paper is formatted correctly:
1. The paper is less than 5 or more than 12 pages long.
1. Paper title and section titles are in BOLD ALL CAPS, subsections are Bold and Capitalize the First Letter of Important Words. Please use the templates.
1. Paper is A4 format, not letter format. Please use the required margins.
1. The copyright notice is incorrect.
1. The running heads are incorrect. Don’t forget that the LastNameLastAuthor is preceded by “, and ”.
1. The citation format is incorrect. Double check the citation format.
1. The biographies are missing. Don’t forget the “author biographies” section.
1. Figures or tables are not referenced in the text or have the incorrect caption format.
1. The author section after the title is not formatted correctly, the number of organizations does not define the number of blocks, or the number of blocks does not define the layout.
1. In the heading on the title page, country names are in all capitals.
1. Paragraphs are not indented.
1. Some fonts in the resulting .pdf are not embedded.
[image: ]
AUTHOR BIOGRAPHIES
A biography is mandatory for each author. A biography starts with an author’s name, then provides their position and a brief summary of their research interests. The biography ends with the email. The biography is not intended to be a comprehensive summary of accomplishments. Note that initial submissions are double blind, so biographies must not be included when submitting your manuscript. Leave space for biographies so that you can include them when submitting the camera-ready version of your paper, after acceptance.
ROMAN CARDENAS is a Teaching Assistant in the Department of Electronic Systems at Universidad Politécnica de Madrid (UPM), Spain, where he is pursuing a Ph.D. in Electronic Systems Engineering in Cotutelle with Carleton University (CU). His research interests include modeling and simulation with applications in the IoT domain. His email address is r.cardenas@upm.es.
BENTLEY JAMES OAKES is an Assistant Professor in the Department of Computer Engineering and Software Engineering at Polytechnique Montréal, Canada. Previously, he was a post-doctoral researcher at the University of Montréal, Canada and at the University of Antwerp, Belgium. He received his PhD at McGill University. His research interests include digital twins, knowledge representation, cyber-physical system verification, model-driven engineering, and model transformations. His email address is bentley. oakes@polymtl.ca.
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